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Software License Agreement

The software license agreement can be found at the following location:
http://www.doremilabs.com/support/cinema-support/cinema-warranties/

Hardware Warranty

The hardware warranty can be found at the following location:
http://www.doremilabs.com/support/cinema-support/cinema-warranties/
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1  Introduction
1.1  Purpose
The purpose of this user manual is to provide guidance on how to use the Doremi Theater 
Management System (TMS) application version 1.4.x. The TMS is based on a graphical user interface 
(GUI) and allows the user to manage several servers connected to a common network.

1.2  Contact
If in need of help or assistance, please contact Doremi Labs Technical Support at:
USA

• 24/7 Technical Support line: + 1-866-484-4004
• Technical Support Email: support@doremicinema.com

Europe
• 24/7 Technical Support line: + 33 (0) 492-952-847
• Technical Support Link: http://support.doremitechno.org/ticketing

Japan
• Technical Support line: + 044-966-4855
• Technical Support Email: support@doremilabs.co.jp

Australia ~ China ~ India ~ Indonesia ~ Korea ~ Malaysia ~ New Zealand ~ Philippines ~ 
Singapore ~ Taiwan ~ Thailand

• Technical Support Email: supportasia@doremilabs.com
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2  GUI Overview
The TMS GUI will automatically launch when logged in as doremi.

• To launch the TMS GUI manually, go to the Start → Doremi Apps. → Theater Management 
menu.

• The Doremi TMS GUI will appear showing the Monitoring tab as presented below (Figure 1):

Figure 1: TMS GUI - Monitoring Tab
• The TMS GUI is composed of a set of tabs that allow access to all available functions of the 

TMS. The tabs are listed below:
◦ Monitoring 
◦ Scheduling 
◦ KDM Overview 
◦ Show Playlist Builder
◦ Screen Management
◦ Content Management 
◦ Control Panel

• The two buttons on the top right corner with left and right arrow icons are backward and 
forward functions. They allow the user to go back to the recently viewed tab (Figure 1).

• The bottom of the frame  will display the complete date at the right corner and the total disk 
space and available free space of the LMS. The font color will change to indicate the available 
free space. A yellow color represents 10-20% and red color represents below 10% of total 
available free disk space (Figure 1).
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3  Quick Start Guide
This quick start guide provides guidance on how to use the TMS GUI in order to configure screens, 
create and schedule SPLs, check associated KDM availability, and manage the associated content 
ingest processes.

3.1  IP Setup
The Networking Configuration feature allows the user to set the network parameters. To access the 
Networking Configuration feature, go to Menu → LMS Control Panel → Networking Configuration. In 
the Devices tab of the window that appears, double click on the Ethernet port that you wish to 
configure. Fill out the fields on the window that appears with the help of your IT administrator. 

3.2  Logging In
To be able to configure screens, the user needs to be logged in as admin.

• Go to the Control Panel tab and click on the User icon.

• The following window will appear (Figure 2):

Figure 2: Authentication Window
• Select admin in the User name field.

• Enter the admin password in the password field.

◦ Doremi Labs, Inc. has the default password.

• Click on OK.

• The user is now logged in as admin.

3.3  Screen Setting
• To perform the set up of the screens, click on the Servers icon in the Control Panel tab.

• The Server Edit screen will appear allowing the user to configure the screens in the 
appropriate manner ( Figure 3).
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 Figure 3: Add Server GUI
• To add a server, click on the Add Server button.

• To remove a server, select it and click on the Remove Server button.

• To scan for available servers, click on the Scan Network button.

◦ The Network Scan window will appear.

◦ Select one or more servers to add and then Click OK to add.

Figure 4: Scan Network Window
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• To manually add a server:

◦ Click on the Add Server button.

◦ Fill in the required information ( Figure 3).

▪ For screen servers, enter the auditorium number, usually between 1 and 32, and 
specify the type of playback (3D or 2D).

▪ The serial number field will be filled automatically once the Save button is clicked.

▪ Select the network server type and the file type.

• Ingest server should only be selected for the LMS. 

▪ Input the server IP and the management IP, with their respective usernames and 
passwords.

▪ Note  : The server IP would typically use the “manager” login type and the management 
IP would typically use the “admin” login type. 

Note: If the LMS Library resides on the TMS server itself, then the IP addresses are the same as the 
TMS. The manager and admin account information has to match the account information on that 
particular screen server. 

• Click on Save when finished.

3.4  SPL Creation
• If Show Playlists are complete, then skip this section and proceed to Section 3.5. 

• Creating a Show Playlist to be ingested on the screen:

◦ Go to the Show Playlist Builder tab.

◦ Click the New button followed by New Playlist.

◦ On the left part of the window, select the composition (CPL) items to add to the playlist.

◦ Select  consecutive CPLs by using the shift key or use the "Ctrl" button to select multiple 
non-consecutive CPLs.

◦ Click on the Add to Show Playlist button to add all the selected CPLs to the SPL panel.

◦ The available content will appear. 

Note: If no composition is visible on the left part of the tab, click the Refresh button.

◦ The two arrow buttons allow the user to change the order of the CPLs in the Show Playlist 
panel. Refer to Section 4.4 for SPL creation details.

• To add an automation cue to a CPL present in the Show Playlist:

◦ Select the desired CPL on the right part of the Show Playlist Builder window.

◦ Select the desired automation cue on the left part of the window.

◦ Click the Add to Show Playlist button. 

◦ The user will be asked to define Automation Cue parameters. See Section 4.4.3.2.2 for 
detailed information.
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Note: Trigger Cues can be added to the Show Playlist. Refer to Section 4.4.3.2.3 for the related 
procedure. 

◦ Save the Show Playlist when finished by clicking on the Save button on the top of the tab.

◦ If there is any content you wish to prevent from being deleted, click on the Edit Locking 
button, check the desired content, and click Save. 

• Creating a Show Playlist Pack:
◦ The TMS also allows the creation of re-usable playlist packs. Click on the New button in the 

show playlist builder; this will bring a pop-up menu with the option: New Playlist Pack.
◦ Click the Add Pack button.
◦ Enter a pack name or select among the pre-defined playlist packs (PRESHOS_PACK, 

TRAILER_PACK, FEATURE_PACK, or POSTSHOW_PACK, Figure 5). 

Figure 5: SPL Pack

◦ An item representing the name of the pack will be added and highlighted in green (Figure
6).
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Figure 6: SPL Pack Added

◦ Proceed by adding CPLs, automation cues and trigger cues.
◦ Save the Show Playlist Pack when finished by clicking on the Save button on the top of the 

tab.
◦ Once saved, the SPL pack will show, in purple, in the left panel, under Playlist Packs. The 

playlist packs can then be added to another SPL like any other CPL or cue item (Figure 7).
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Figure 7: SPL Packs Added

3.5  SPL Scheduling
To schedule a Show Playlist playback, follow the steps below: 

• Go to the Scheduling tab. See Section 4.2 for additional guidance about this tab.

• Click on the Add Schedule button.

• The following window will appear (Figure 8): 
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Figure 8: Add Schedule Window

• Select the Show Playlist that needs to be scheduled within the Show Playlist box.

• Choose the Screen Number and the date/time that is to be scheduled.

• Click on the Add button when finished.

• The new schedule will appear on the main window of the Scheduling tab.

• If the SPL is not on the SMS, then the TMS will initiate the SPL transfer to the SMS.
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3.6  Uploading KDMs 
A Show Playlist might contain encrypted CPLs. To identify an encrypted CPL, look for the lock icon to 

the left of its name in the Show Playlist builder window ( ). Each encrypted CPL requires a valid 
KDM. If this is the case, make sure that a valid KDM exists for each encrypted CPL in order to be able 
to perform the playback.

• Go to the KDM Overview tab. See Section 4.3 for additional guidance on this tab.

• Check in the displayed list of available KDMs to see if there is one for each encrypted CPL in 
the Show Playlist.

• If a KDM is missing, click on the KDM Upload button in order to upload it and then follow the 
steps.

• Use the Browse button to select the proper KDM folder and upload the KDM (Figure 18).

3.7  Content Management
The Content Management tab will display the status of all ingest jobs. It will show the progress of the 
current jobs and it will list all pending jobs. The TMS can execute transfers to four screens 
simultaneously. The Content Management tab will allow users to cancel a CPL or SPL transfer.

3.8  Logout
To prevent unauthorized changes to settings and scheduling, click logout.

• Go to the Control Panel tab and click on the User icon.

• The following window will appear (Figure 9):

Figure 9: Authentication Window
• Click on Logout.
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4  TMS GUI Tabs Description
4.1  Monitoring Tab

• To enter the Monitoring tab, click on Monitoring on the top of the GUI.
• The Monitoring window is composed of two different parts  (Figure 10): 

1. The top part lists all the screens added to the TMS together with their states: offline, 
online, and playing.

2. The bottom part displays information about the selected screens.

4.1.1  Presentation
Screens are listed vertically under the screen column header. Each screen is identified with an icon 
displaying the screen number inside it. The icon's color and shape reflects the current status of the 
SMS. Below are the different icons used:

•  :Blue square indicates online and idle status.

•  :Green triangle indicates online and playing content.

•  :Red hexagon indicates offline.

•  :Orange square indicates that the media block is disconnected.

• A smaller icon can appear next to the screen number when the available free space drops 
below a certain threshold.

◦  :A warning icon in yellow indicates that the  configured warning threshold (11% - 20%) 
for the remaining free space was reached. 

◦  :A critical icon in red indicates that the configured critical threshold (10% or less) for the 
remaining free space was reached.
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Figure 10: TMS GUI - Monitoring Tab
Note: The small warning/critical icon can be used to display some other warnings. Point the mouse 
over the screen icon to display the description of the errors or warnings.

To the right of the screen icon, the following information is displayed only when the screen is in 
playback mode.

1. A Show Playlist name is displayed in conjunction with one or more bars beneath. The bars 
represent the different clips in the SPL. The short bar is for trailers and the long bar is for 
features. 

◦ Hovering over the name will list the content in each SPL.

◦ The letters above the bars indicate what type of content the clip contains:

▪ FL= Flat

▪ SC= Scope

▪ HD= High Definition

▪ FU= Full

▪ PA= Pattern

2. Elapsed time.

3. Remaining time.

4. Next Show.

5. Projector.
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• The last two columns can appear and disappear by clicking on the Arrow icon.

• To access the Screen Management tab associated with the selected screen, double-click on 
the screen icon and the GUI will display the Screen Management tab (Section 4.5).

• Using the mouse to hover over the SPL name or the clip bars will list the content found in the 
SPL. 

4.1.2  Screen Information
The bottom part will display information specific to the server on a particular screen (Figure 10).  By 
selecting a screen on the top, the following information will be displayed:

1) Server Serial Number.

2) Software and Firmware version.

3) Total disk space; used and free. The color of the free space will change if it drops below a 
certain threshold. The color yellow indicates a free space between 10% and 20%. The color 
red indicates free space below 10% of total disk space.

4.2  Scheduling Tab
4.2.1  Standard Use

• To enter the Scheduling tab, click on Scheduling on the top of the GUI at any time during the 
TMS GUI usage.

•  The Scheduling tab is illustrated below (Figure 11):

Figure 11: TMS GUI - Scheduling Tab
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• Edit Links button: This will link a specific movie name to an SPL.

• Previous Day and Next Day button: These buttons will show the schedule by the selected view 
period. It can be daily, weekly, monthly, or yearly.

• Date Selection field: This will allow the user to specify the starting day of the schedule.

• Refresh button: This will refresh the scheduling window.

• View field drop-down menu: This will specify the period to display in the scheduling window 
starting with the day specified in the date selection.

• Delete Schedule button: This will delete the selected entry from the schedule. The selected 
entry will be deleted immediately without confirmation.

• Delete All Schedules button: This will delete the entire schedule on both the TMS and the 
screens associated with the system. A confirmation is required in order for the operation to be 
completed. Only a manager login can execute this operation. The operation will delete the 
schedule only; no content will be lost in the process.

• Add Schedule button: This will allow the user to manually schedule an SPL on a specific 
screen at a specific time and day.

• The Scheduling window will list all the entries starting from the date in the Date Selection up to 
the period selected in the View drop-down menu.

• Schedules that have already passed will be shown with the line highlighted in gray.

4.2.1.1  Entry Description
• Each entry takes one line and is composed of four fields as listed below:   

◦ Date and Time

◦ Screen Name

◦ Movie Name

◦ Notes 

• The font color will reflect the status of the entry.

◦  A black font is ready and the red font indicates an error. 

◦ A gray font is for past entries.

• The error type will be reflected in the notes. 
4.2.2  Manager/Administrator Use
If the user is logged in as either manager or admin, they will be able to modify the settings. In this tab, 
it corresponds to:

• A schedule addition

• Schedule(s) deletion

• Links editing

To add a schedule, click on Add Schedule:

• The following window will appear (Figure 12): 
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Figure 12: Add Schedule Window
• To schedule a playback of a Show Playlist for a given auditorium and time, click on Add when 

finished.

• The new schedule will appear in the schedule list.

• Select the appropriate View mode from the drop-down menu.

To delete an existing schedule, select it in the schedule list and click on Delete Schedule.

• The schedule will disappear.

• To delete all the schedules, click on the Delete All Schedules button.

To link a movie listed in the POS file to a specific Show Playlist, click on the Edit Links button (Figure
13).

Figure 13: Edit Links Window – Unlinked View
• The left side provides the list of movies listed in the POS File. This largely depends on whether 

or not the Show Playlist is linked with the POS file.

• If the Unlinked button is clicked, the Movies window will display the list of movies that are not 
linked to any Show Playlist.

• Select one movie from the POS File and one from the Show Playlist and click on Link.
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• The Show Playlist will be linked to the movie title defined in the POS File.

• The playback of the Show Playlist will be performed according to the schedule of the linked 
movies title defined in the POS File.

• To view the movie titles already linked to Show Playlists, click on Linked on the bottom of the 
Edit Links window.

• The following window will be displayed (Figure 14):

Figure 14: Edit Links Window – Linked View
• From this window, the user can select one title and unlink it by clicking on the Unlink button.

• To view the whole list of movie titles listed in the POS file, whether they are linked or unlinked, 
click on All.

• The Movies window will reflect the whole movie list, indicating the movie titles that are unlinked 
in red, as presented below (Figure 15):

Figure 15: Edit Links Window – Linked View
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4.3  KDM Overview Tab
• To enter the KDM Overview tab, click on KDM Overview on the top of the GUI at any time 

during the TMS GUI usage.
• The KDM Overview tab will display all the KDMs available on the network using a color code to 

indicate their validity.
• Below are the color codes and their correspondences: 

◦ A green line corresponds to a KDM valid for more than 48 hours.
◦ A yellow line corresponds to a KDM valid for less than 48 hours.
◦ A red line corresponds to a KDM that is not currently valid, but will be valid in the future.

Figure 16: KDM Overview Tab
• The first column indicates on which screen the KDM can be used, and the next columns 

indicate the Content Title of the corresponding Composition Playlist. It also indicates the start 
and end dates of the KDM validity window (Figure 16).

• The following color significance (Figure 17) is available by clicking the Legend button (Figure
16). 

Figure 17: KDM Highlight Window
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• To delete a KDM, select it in the KDM list and click the Delete KDM button (Figure 16).

• To delete all expired KDMs, click the Delete Expired KDM button (Figure 16).

• The KDMs Upload button (Figure 16) allows for ingestion of KDMs from the TMS (USB or local 
directory). Use the Browse button to select the folder from which to ingest the KDMs (Figure
18).

Figure 18: KDM Upload Window
• To upload one or more KDMs, select it and click the Upload Selected button.

• To upload all KDMs, click the Upload All button.

• Click the Close button to close the KDMs Upload window.

Note: Right clicking on an Uploading of KDM line in the bottom part of the tab will show a menu to 
clear the status logs or delete the selected message (Figure 19).

Figure 19: KDMs Upload Window – Right Click Menu
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4.4  Show Playlist Builder Tab

4.4.1   Tab Overview

• To enter the Show Playlist Builder tab, click on Show Playlist Builder at any time during the 
TMS GUI usage (Figure 20).

• The Show Playlist Builder tab contains:

◦ A left part with all the Digital Cinema Packages (DCP) that were found on the LMS: 
features, trailers, and advertisements. They are together with the available automation 
cues and trigger cues. The Whole Multiplex feature will show all the available DCPs found 
on one or more screens. All content that is shown in bold font exists on the LMS and on 
one or more screens. Content with a fine line does not exist on the LMS.

◦ A right part used to display the content of a given Show Playlist, that is already created or 
existing. A Show Playlist is described in the next step.

Note: Content type is differentiated by color and font. Pointing to a certain content will make an 
informative tool-tip showing the format and location available (Figure 20).

Figure 20: Show Playlist Builder Tab
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4.4.2   Colors
Different colors represent different formats in the Show Playlist Builder:

• Flat:

◦ 2D is dark blue.

◦ 3D is light blue.

• Scope:

◦ 2D is dark green.

◦ 3D is light green.

• HD:

◦ 2D is dark brown.

◦ 3D is light brown/orange.

• Full:

◦ 2D is dark red.

◦ 3D is light red.

4.4.3   Show Playlist Creation
A Show Playlist defines a succession of DCPs and Automation Cues. It provides the events chain to 
be taken into account for the playback of a show. A Show Playlist can be newly created or an existing 
Show Playlist can be opened and edited.

4.4.3.1  Principle
The Show Playlist Builder tab allows the users to create their own Show Playlist from the elements 
listed in the Contents window.

• To add an element to the Show Playlist, select it. The element will be reverse highlighted.

• There are two ways to find content in the tab.

• To search for a specific CPL, click on the Find Content button (Figure 22) and type 
in the name of the CPL (Figure 21).

Figure 21: Find Content Window
• To filter the CPLs, click on the Filter button (Figure 22). The user can filter by 

advertisements, automation cues, features, patterns, playlist packs, policy, psa, 
rating, shorts, teasers, tests, trailers, transnational, trigger cues, and a custom 
search. 
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Figure 22: Find Content Options
• There is also a Sorting Option drop-down list that allows the user to sort the content on the 

left side of the window by name, format, and locked material (Figure 22). See Section 4.4.5 
for more information on locked material.  

• Click on the Add to Show Playlist button to add the highlighted CPL.

• The element will appear on the right part of the window. Repeating this operation with all the 
required elements will lead to a Show Playlist (Figure 23):
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Figure 23: Show Playlist Creation

• If the user is trying to add content with different formats, the Dissimilar Content window will 
appear asking the user if they would like to continue. Click Add Anyway to add the content to 
the SPL regardless of its format. 

Figure 24: Dissimilar Content Window

• If an element needs to be removed from the Show Playlist, select it in the Show Playlist 
window and click on Remove.

• The Ingest SPL button (Figure 23) forces the SPL ingest on a selected screen right away. The 
SPL ingest window that will appear is presented below (Figure 25): 
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Figure 25: Show Playlist Ingest Window
• Select the SPL to ingest and the destination screen, then click on the Start Ingest button 

(Figure 25).

• Clicking on the SPL Properties button (Figure 23) will make the SPL Properties window visible 
(Figure 26).

Figure 26: SPL Properties Window 
• If necessary, change the name of the SPL and set to 3D SPL or 2D SPL using the Display 

Mode list box (Figure 27).

• The default setting is 2D SPL.

 TMS.OM.000177.DRM         Page 27                                                              Version 1.3
Doremi Cinema LLC

Start 
Ingest
Button

Close 
Button



Figure 27: SPL Name and Display Mode Settings
• To hide the SPL Properties window, click on the Close button.

• Click the Save button, located on the top of the tab, to record the SPL settings (Figure 27).

• If it is not saved, the SPL settings will be ignored.

4.4.3.2  Element Types
Different types of elements are available:

• Audio-visual content: feature, test content, trailer, rating, and black.

• Automation cues: Macro Automation cues from generation based on the Macro Editor 
application.

• Trigger cues: based on the generation of the Macro Editor application.
4.4.3.2.1  Audio-Visual Content
When audio-visual content is encrypted, a lock icon is displayed at the beginning of its line. It means 
that a corresponding KDM will be required to play content (Figure 28):
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Figure 28: Encrypted Content Tag
4.4.3.2.2  Automation Cues
Macro Automation Cues can be added to an element of the Show Playlist.

• Select the element in the right part of the window.

• Select the desired Automation Cue on the left part of the window.

• Click on the Add to Show Playlist button.

• The user will be asked to define the offset of this Automation Cue from the beginning or the 
end of the chosen element using the following window (Figure 29):

Figure 29: Automation Cue Offset Definition
• Click the OK button when finished.

• The Macro Automation Cue will appear under the element on the right part of the tab (Figure
30):

 TMS.OM.000177.DRM         Page 29                                                              Version 1.3
Doremi Cinema LLC

Offset indicating the 
starting point of the 
Macro Automation 

Cue within the 
element

Name of the element 
defined by this Macro 

Automation Cue

Arrow buttons to 
use to define the 

offset

Lock 
Icon



Figure 30: Automation Cue Added to an Element
• This operation is repeatable for the same element or for another element of the Show Playlist.

4.4.3.2.3  Trigger Cue
A Trigger Cue allows for the planning of the execution of Macro Automation Cues when the underlying 
condition happens.

For example, if a Trigger Cue is based on the condition, “Wait for GPI #1 ON,” the user can link a 
specific Macro Automation Cue as presented above in order to execute such Macro when GPI #1 is 
asserted.

The user has the choice to program a Trigger Cue to be available during the whole Show Playlist or 
only during a specific Show Playlist element.

To define a Trigger Cue for the whole Show Playlist:

• Select a Trigger Cue from the left side of the GUI.

• Click on Add to Show Playlist.

• The following window will appear (Figure 31):
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Figure 31: Trigger Cue Addition – Whole Show Playlist
• Select the Macro Automation Cue to associate with the Trigger Cue by clicking on the 

Automation Cues window. 

• The default scope for the Trigger Cue is all the elements of the Show Playlist.

•  Click the OK button.

• Creating a Trigger cue for only one element of the Show Playlist involves the following: 

◦ Select the element on the Show Playlist on the GUI.

◦ Select the Trigger Cue and add it to the left window of the GUI.

◦ Click on Add to Show Playlist.

◦ The same window as in Figure 31 will be displayed.

• Associate a Macro Automation Cue using the same process described above. 

• Check on the box to indicate that the trigger is only available for the element.

• The line below contains the name of the element that was selected (Figure 32).
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Figure 32: Trigger Cue Addition – Single Element

4.4.3.2.4  Element Recording
Two arrows allow the user to change the order of the elements in the Show Playlist (Figure 33 and 
Figure 34): 

Figure 33: Arrow Pointing to the Top

Figure 34: Arrow Pointing to the Bottom
Using these arrows allows for each element to be either moved to the top or to the bottom of the Show 
Playlist.  

• To move an element to the top, select it and click on the arrow pointing to the top.

• To move an element to the bottom, select it and click on the arrow pointing down.

• Repeat these steps until the correct order of the elements is obtained.
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4.4.3.2.5  Refresh Buttons
Two Refresh buttons are available in this tab (Figure 36). 

• The Refresh Contents List button will do a quick refresh without rescanning the content.

• The Refresh Ingest Servers button is used to synchronize the contents view with the content 
on the ingest servers. This is necessary to show the newly transferred content on the 
LMS/ingest servers. When clicking on this button, the following screen will appear (Figure 35):

Figure 35: Ingest Servers Scan Window 

• When scan is complete, click the Close button.

4.4.3.3  Properties Button
The user can view the properties of the elements of the Show Playlist by selecting one of the 
elements, which is located on the right part of the window and clicking the Element Information button 
as illustrated in Figure 36. Properties of the Automation events can also be edited using this button.

Figure 36: Refresh and Element Information Buttons
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• With Trigger Cues and Automation Cues, the user will be able to edit the properties that were 
asked for when the element was added to the Show Playlist. 

• With audio-visual elements, a window listing the characteristics of the element will be displayed 
(Figure 37).

Figure 37: Example of Information Related to Audio-Visual Content

Note: Some of the content (Encoding, Channels, and Quantization) will not be available if the content 
is not present on any of the screen servers. 

4.4.3.4  Show Playlist Saving
When a Show Playlist has been created according to the procedure presented above, it can be saved 
using the Save button assuming that the user is logged in as admin or manager. Click the Save button 
to save the Show Playlist (Figure 38). Clicking the Save Button will also give the user the option to 
export a SPL from a USB (Figure 39). 
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Figure 38: Show Playlist Saving  

Figure 39: Export Button
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4.4.3.5  New Show Playlist
• If a new playlist needs to be created, click on the New button  (Figure 38). This action will 

remove the Show Playlist display on the right part of the user display.

Note: Save the current Show Playlist before clicking on New, otherwise it will be lost.

4.4.4  Show Playlist Opening
If a Show Playlist already exists, it can be opened using the Open button (Figure 38). The Show 
Playlist will be displayed into the right part of the user interface as if it was created according to the 
procedure presented above. Clicking the Open button will also give the user the option to import a SPL 
to a USB (Figure 40). 

Figure 40: Import Button

4.4.5  Deletion Operations
To perform the deletion operations, the user needs to have manager or admin privileges.

• To delete content from the server, select the content to delete from the left part of the window.

• Click on the Delete Content button (Figure 38).

• To delete existing Show Playlists, click on the Delete existing SPLs button (Figure 38).

• The following window will appear allowing the user to select which Show Playlist(s) to 
delete (Figure 41).
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Figure 41: Delete SPL Window

• Select the Show Playlists to delete by holding the "Ctrl" key on the keyboard. This function 
will allow users to select multiple SPLs. Or click the Select Outdated SPLs button to select 
all SPLs that are not linked (Figure 42):

Figure 42: Delete SPL Window - SPLs Selected
• Click the Delete button to perform the deletion.
• A user with admin privileges can prevent any other user from deleting specific CPLs by 

locking it using the Edit Locking button.
◦ Click on the Edit Locking button, select the content to be locked, and click Save 

Locking (Figure 43).
• If the content has been locked using the Edit Locking button, and the user tries to delete 

the content, a window will appear telling the user that the content is protected (Figure 44). 
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Figure 43: Edit/Save Locking  

Figure 44: Content Deletion
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4.5  Screen Management Tab

4.5.1  Tab Overview
• To enter the Screen Management tab, click on Screen Management on the top of the GUI.

• The Screen Management tab allows different functions depending on the logged in status. If 
the user is not logged in as manager or admin, the tab will only allow the user to view the 
current Show Playlist playback, on a specific screen.

• It is divided into two tabs: the Playback tab and the Control tab.
4.5.1.1  Playback Tab

• The screen number can be selected using the list-box available on the top of the tab (Figure
45):

Figure 45: Screen Management: Playback Tab
• The left part of tab displays the Show Playlists and the Composition Playlists (CPLs). Both are 

available on the selected screen in the Show Playlists window and in the CPLs window (Figure
45).

◦ Clicking on the Filter button will allow the user to filter the icons into advertisements, 
features, policies, psa, shorts, teasers, tests, and a custom search.  

• The Playback window (the right part of the window) contains the Show Playlist progress list-
box. The list-box displays the current playback position within the Show Playlist using a green 
flag. The elements already played are flagged using a yellow mark whereas the elements that 
are not played for the moment do not have any flag at all (Figure 46).
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Figure 46: Show Playlist Progress List-box

4.5.2   Applying Manager/Administrator Accounts
When logged in as manager or admin, the user will be able to navigate within the Show Playlist. To 
navigate within the Show Playlist, the user must be in Pause mode. The user is able to load a Show 
Playlist and manage CPLs and SPLs (Figure 47).

Figure 47: Screen Management Tab - Manager Account
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4.5.2.1  Pause Mode
• To enter Pause mode, click the Pause button (Figure 47).

• While being in Pause mode, the user can skip to the previous clip or to the next clip within the 
Show Playlist. The user can also directly go to three minutes after the pause location or go 
back to three minutes before the current pause location within the current clip (Figure 48):

Figure 48: Preview Tab in Pause Mode

• Click the Play button to re-start the playback from the selected point.

• To set the Loop mode, meaning that the current playlist will be played in loop, select the Loop 
mode in the list-box.

• While in pause mode, the user can locate within the current clip by clicking on the Clip 
Remaining Time value (Figure 48).

Figure 49: Locate Time Code Window
• Enter the desired time code value or use the two arrows on the right and click the Ok button 

(Figure 49).

• The user will have jumped to the specified time code within the current clip (Figure 50).
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Figure 50: Locate Result 

• To resume back to playback, click the Play button.

4.5.2.2  Show Playlist Loading
The manager or admin privileges allow the user to stop the current Show Playlist. The same privileges 
allow the user to load another Show Playlist from the Show Playlists window.

• To load another available Show Playlist:

• Click the Stop or Pause button.

• Click on desired Show Playlist in the Show Playlists window.

• The content of the selected Show Playlist will be displayed in the Show Playlist Progress 
list-box.

• Click the Play button to start playback.
4.5.2.3  CPL and SPL Management

• When logged in as admin or manager the user will be able to add or delete a SPL and CPL 
(Figure 51).
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Figure 51: Screen Management Tab – Administrator Account
• To remove a Composition Playlist, select the CPL from the CPLs window and click the 

“Remove CPL” button.

◦ If the content has been locked using the Edit Locking button (Figure 43), and the user tries 
to delete the content, a window will appear telling the user that the content is protected. 

• To delete a Show Playlist, select the Show Playlist from the Show Playlist window and click the 
“Remove Show Playlist” button.

• To add a Show Playlist, click the Show Playlist button.

• The following screen will be displayed (Figure 52):

Figure 52: Window to Add a Show Playlist
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• Choose the required Show Playlist and click on Send.

• The selected Show Playlist will be added to the screen and the Show Playlists window will be 
updated accordingly.

• The presence of all the required assets will be checked and the missing assets will be ingested 
by the selected screen. The ingest process will be visible in the Content Management tab.

• As admin or manager, the user will be able to lock the playback mode.

• To lock the Manual mode, click on the Mode button which is located above the Manual 
Playback tag on the top of the window.

• The Schedule Playback window will appear indicating the new playback mode.

• The following Screen Management  tab will appear (Figure 53):

Figure 53: Screen Management Tab – Scheduled Playback Mode
4.5.2.3.1  CPL Icons

The following icons represent the following KDM status:
• No icon: a 2D not encrypted CPL
•  - Green lock: a 2D encrypted CPL with valid KDM that will expire in more than 48 hours

• - Red lock: a 2D encrypted CPL with missing/expired KDM
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• - Orange lock: a 2D encrypted CPL with KDM that will expire in less than 48 hours

• - 3D black: a 3D not encrypted CPL

• - 3D green: 3D encrypted CPL with valid KDM that will expire in more than 48 hours

• - 3D red: 3D encrypted CPL with missing/expired KDM

• - 3D orange: 3D encrypted CPL with KDM that will expire in less than 48 hours

4.5.2.4  Control Tab
The Control tab enables the user to execute Macro Cues on a selected screen (Figure 54). 

Figure 54: Screen Management: Control Tab
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4.6  Content Management Tab
• To enter the Content Management tab, click on Content Management on the top of the GUI 

(Figure 55).

Figure 55: Content Management: Ingest Progress Tab
• There are two tabs present: the Ingest Progress tab and the Logs tab.

4.6.1  Ingest Progress Tab
• In the upper part of the window, all the files that are being ingested will be shown. 

• The lower part of the window will show the ingest queue. 

• The upper part of the tab shows information regarding the percentage of the asset already 
being ingested. 

Note: A server can only ingest one package at a time. Trying to ingest content on a screen that has its 
local storage full will result in the ingest session being put on hold. The Note column will display a 
message that states, "Not enough disk space." It will resume once there is enough disk storage space.

• Two cancel buttons are available: 

1) Cancel Ingest button will cancel the currently running ingest process. 

2) Cancel SPL Ingest button will cancel the selected running ingest and removes queued 
content that is part of the same SPL. 

Note: When an ingest is canceled using the Cancel Ingest button, the ingest will be re-started 
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automatically by the TMS. It will not re-start automatically if the associated schedule is deleted from 
the Scheduling tab.

• The user can also pause and resume an ingest using the Pause and Resume buttons (Figure
55).

• Two types of ingest are possible: Automatic Content ingest and Manual ingest. 

1) Automatic Content ingest: SPL content will start transferring to the screen if the 
scheduled SPL content is not present on the screen server.

2) Manual ingest: Using the Ingest SPL  button in the Show Playlist window (Figure 23).

• The user can also change the priority of the ingest using the Edit Priorities button (Figure 55).

◦ Select an ingest and click on the Edit Priorities button. A window will appear (Figure 56).

◦ To move an ingest up in the list, increase the number in the priority field. 

▪ Numbers can range from 0 to 100, with the higher number indicating a higher priority. 

▪ Once the priority is changed, that ingest will move to reflect its priority. For example,  an 
ingest with a priority level of 5 will appear before an ingest with a priority level of 3. 

Figure 56: Edit Priorities Window

4.6.2  Logs Tab
The Log tab shows Ingest logs of the selected screen.
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Figure 57: Content Management: Logs Tab

4.7  Control Panel Tab

4.7.1  Tab Overview

• To enter the Control Panel tab, click on Control Panel on the top of the GUI.

• The Control Panel tab allows for the user to be logged in specifically as admin or manager.

• The Control Panel tab will also allow the user to view information about the server.

• Clicking on the Control Panel tab will display the following window (Figure 58):
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Figure 58: Control Panel Tab
Note: The user needs administrator privileges to add or remove servers, load POS files, and generate 
reports.

• Clicking on the About button will provide the TMS version information (Figure 59).

Figure 59: About Window

4.7.2  User Management
• To change the user, double-click on the User icon (Figure 60).
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Figure 60: Authentication Window
• Choose the appropriate user-name and enter the corresponding password.

• Click on the OK button.

• To use the TMS without any specific user privileges, click on the Logout button.

• The different rights and privileges associated with each user name are presented in the 
following section.

4.7.2.1  Administrator User Rights
• When logged in as admin, the user is allowed to perform all functions including:

◦ Edit links

◦ Add and delete schedules

◦ Ingest content on the LMS

◦ Load a POS file

◦ Browse and edit screen properties

◦ Create and save an SPL 

◦ Control SPL playback

◦ Generate reports

◦ Upload and delete KDMs
4.7.2.2  Manager User Rights

• When logged in as manager,  the user is allowed to perform only the following functions: 

◦ Edit links

◦ Add and delete schedules

◦ Ingest content on the LMS

◦ Upload and delete KDMs

◦ Create and save an SPL

◦ Browse screen properties

◦ Control SPL playback
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4.7.2.3  Simple User Rights
• When not logged in as either admin or manager, only the available functions are possible: 

◦ Upload KDM

◦ Refresh

◦ Create an SPL, but not save it

◦ Browse screens and screen properties, but not edit them

◦ Browse tabs

4.7.3  Servers 
• To view the information related to the available screens, click on the Servers button in the 

Control Panel tab (Figure 61).

Figure 61: Netmap Edit Window

Note: Only the LMS server called "TMSLIBRARY" will have the Server Type field set as an ingest 
server. All other servers must have this property unchecked.

Note: Only users logged in as admin will be able to edit the screen information. Other users can view 
the information, but not edit or modify the information.

• To add a server when logged in as admin:

◦ Click on the Add Server button.

◦ A new server will be added to the server list allowing the user to define the settings.

◦ Click on Save to validate the action. Server names can include UTF-8 characters.
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• To remove a server, when logged in as admin:

◦ Select the desired server in the server list and click on the Remove Server button.

◦ Click Save to validate the operation.

Note: If the Confirm Password field does not contain the same password as the Password field, the 
asterisk (*) will be displayed in red and not green (Figure 62):

Figure 62: Wrong Password - Asterisk in Red
• If the keyboard is in Caps Lock mode, a message will flash across the top of the window to 

alert you to the issue  (Figure 63):

Figure 63: Caps Lock Symbol
4.7.4  POS File
A POS file has the date, time, movie title name, and the associated auditorium number of the shows.

• To specify the POS file location, click on the POS File icon (Figure 58).

• The user will need admin privileges to load a POS file (Figure 64).
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Figure 64: POS File Window
• Use the Browse button to define the POS file location.

• The frequency at which the POS file is to be inspected is to be defined in the Refresh 
Informations window.

• The Reload Now button allows the user to force the TMS to reload the POS file specified in the 
location field.

• Schedule shows will start X seconds earlier to account for the preshow duration.

• In the example above, the value is 300 seconds which equates to 5 minutes.

• Click the OK button when finished.
4.7.5  Ingest

• The Ingest icon allows the user to ingest content on the selected screen (Figure 65):

Figure 65: Ingest GUI
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• Click on the Ingest button to start ingestion of the selected content.

• To select multiple items, click on the "Ctrl" button and then click on the desired items.

• After selecting multiple items, click on the Ingest button.

• The selected items will be reverse highlighted after being selected for ingestion.

• Click the Close button when finished.

Note: The items highlighted in gray have been ingested on the LMS. The items in black are not 
ingested.

4.7.5.1  Monitor Tab
To see the progress of items being ingested, click on the Monitor tab (Figure 66). It will provide a 
description of the ingest, when the ingest was scheduled, when it started, and when it finished. 

Figure 66: Ingest Monitor Tab

4.7.5.2  Satellite Ingest 
The Satellite Ingest icon serves the same function as the Ingest icon, however, it specifically allows for 
ingests from Satellite servers. It ingests from servers configured as satellite in the Control Panel→ 
Server tab. 
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4.7.6  Disk Cleanup 
The Disk Cleanup tool scans for any incomplete CPL packages or orphan asset files. The Disk 
Cleanup tool helps with freeing up disk space by allowing the deletion of any incomplete content 
package present on the LMS server. The disk cleanup utility is run from the Control Panel tab of the 
TMS software (Figure 67):

Figure 67: Disk Cleanup of the Orphan Assets
• Select any item that shows a size greater than 0KB and click on Continue (Figure 68).

Figure 68: Orphan Assets Size Checklist
• Once finished with Disk Cleanup of Orphan Assets, the user needs to re-run the Disk Cleanup 

to make sure that the previously selected Orphan Assets or complete CPLs are cleaned 
(Figure 69): 
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Figure 69: Completed Cleanup of Orphan Assets and Incomplete CPLs
4.7.7   Log Report Generation
The user will need to be logged in as admin to generate log reports of the TMS.

• After selecting the Generate Report button in the Control Panel tab, a confirmation window will 
appear which will ask about a log report generation (Figure 70):

 

Figure 70: Log Report Generation Confirmation

• Click Yes to generate a log report (Figure 71).

Figure 71: Log Report Generation Progress Bar

• The user will be notified about the file path once the process is complete (Figure 72).

Figure 72: Log Report Notification

• Click on the OK button when finished.
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4.7.8  Multiplex Macro Execution
The Multiplex Macro Execution feature allows the user to schedule a macro cue on all screens 
simultaneously. 

• Click on the Multiplex Macro Execution button (Figure 58).

• The following window will appear (Figure 73):

• Select a macro from the drop-down list. 

• Click the Execute button to proceed with the action or Quit to cancel the action.

◦ The user can also click the check-box to prevent the macro cue from being executed on 
any screen that is currently in playback. 

• The user can also clear the logs on the bottom part of the screen by clicking the Clear Logs 
button. 

Figure 73: Multiplex Macro Execution
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5  LMS  Control Panel
To access the LMS Control Panel, go to Menu → LMS Control Panel.

• The following window will appear (Figure 74):

Figure 74: Control Panel Window

5.1  Account Manager
• To edit, delete, or create a user account, click on the Account Manager icon on the Control 

Panel tab (Figure 74).
• The following window will appear (Figure 75):

Figure 75: Account Manager Window
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• To create a new user account, click on the Add button.
• Enter the user name along with the full name (Figure 76).

Figure 76: New User Creation - Information Window
• Define the privileges of the new user by listing the account as: ShowManager, Administrator, 

Projectionist, or SuperUser.

• Choose if the account will be a Application User or System User, by checking the appropriate 
radio button. The two types are described below:

1) An Application User has access only to the TMS and the associated files with the TMS. 

2) A System User has access to the TMS and can log-in to the system from the welcome 
screen, which is located outside of the TMS GUI.

• Enter the new password by clicking on the Set Password (Figure 77).

Figure 77: Password Window
• Click on the Set button.

• Click on the Save button to complete the new user process (Figure 78).
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Figure 78: Account Manager Window - New User Added
• To edit an account, select the account and then click on Edit (Figure 79).

Figure 79: Information Window - User Edit
Note: The user will be able to edit the full name, privileges, and set the password. The user will not be 
able to change the login type and user name.

• Click on the Save button when editing is complete.

• To delete a user, select it in the account manager and click on the Delete button.

5.2  Applications Configuration
The Applications Configuration feature allows the user to set the parameters for log retrieval, the TMS 
GUI, and the TMS service. Hovering over the individual field will provide more information on each 
section. 

• To access this feature, click on the Applications Configuration icon. The following window will 
appear (Figure 80): 

 TMS.OM.000177.DRM         Page 60                                                              Version 1.3
Doremi Cinema LLC

New User Added 



Figure 80: Application Configuration

5.2.1  Log Retriever
This application is used to configure the parameters of log retrieval. The default parameters are 
explained below. 

• Retrieval start and end time: Secure and operational logs will be polled from the screen server 
between 5:00 AM and 9:00 AM, which is often a time a server is not playing any content.

• Realtime Interval: The Log Retrieval service collects real time operation logs from screen 
servers and store them in a database for quick viewing in the SM Viewer user interface. This 
parameter represents the real time logs retrieving interval. By default, the TMS will collect 
every 5 minutes. Note that the real time operational logs collection is delayed when a server is 
in playback mode to avoid any conflict with playback.

• Booking Time: This is the time at which the requested day logs will start. By default, the Log 
Retrieval service will collect the secure and operation logs of each server for events happening 
between 04:00:00 and 04:00:01 of the previous day.

• Past days: This is the number of days in the past to look and retrieve log files that have not 
been downloaded. By default, the Log Retrieval service will go back 10 days in the past.

5.3  Date Configuration
By clicking on the Date Configuration icon, the user can configure the date, time, and time zone.
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5.4  Display Configuration 
The user can configure the display of the screen by clicking on the Display Configuration icon. 

5.5  Log Manager
Clicking on the Log Manager icon will allow the user to configure the settings for log uploading.

• To configure log settings, click on the Log Manager Icon in the LMS Control Panel (Figure 74).

• The following window will appear (Figure 81). 

Figure 81: Log Manager

• Click the New button to add a new server.

• Check the Enable box to make sure that the server becomes active, i.e., logs will be sent to the 
server.

• Selecting the Active Log Uploading check-box will activate log uploading for all manager sites. 

• Select the Frequency of sending logs from the options:

• Daily: specify time

• Weekly: specify day and time

• Enter the name of the server in the Name field.

• The Number of Retries field and the Wait Between Retries field are there to define how many 
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times the uploader daemon should retry the FTP upload in case of failure and the interval to 
wait between two retries.

• Enter the appropriate URL destination in the URL field. This represents the URL of an existing 
FTP site where you would like to have the logs uploaded (e.g., ftp://127.0.0.1/folder/).

• Site ID: This field is used to differentiate between files uploaded from different TMS sites. It is 
used in the name of the uploaded file.

• Enter the username and password required for authentication to the FTP site.

• The Home Directory field indicates the folder into which the files will be stored. 

• The Security and System logs are checked by default, meaning that they are included in the 
log upload.

• Un-check the Security (SMPTE) logs box to exclude the security logs from the log file 
that will be uploaded.

• Un-check the System (Doremi) logs box to exclude the System logs from the log file 
that will be uploaded.

• The user can also check the box to compress the files before uploading.

• Once finished, click the Save button.

• Click the Test button to test the connection to the server where the logs will be uploaded. 

• You can delete a server by selecting it from the list and clicking the Delete button.

• To quit the application, click the Quit button.

Note: Logs not collected for few days are automatically collected as soon as possible. If FTP server is 
not reachable, logs are kept and will be sent as soon as it is possible.

5.6  Macro Execution
The Macro Execution icon serves the same function as the Multiplex Macro Execution icon in the TMS 
Control Panel. For more information on this function, refer to Section 4.7.8. 

5.7  Netmap Editor
The Netmap Editor icon serves the same function as the Servers icon in the TMS Control Panel. For 
more information on this function, refer to Section 4.7.3.
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5.8  Networking Configuration
The Networking Configuration feature allows the user to set the network parameters. Clicking on the 
Networking Configuration icon will open the following window (Figure 82):

Figure 82: Network Configuration

• Double-click the Ethernet port that you want to configure (Figure 83).

Figure 83: IP Configuration

• Make sure that the Activate Device and Allow All Users check boxes are selected and that the 
Enable IPv6 check box is not selected. 

• Click the Statically Set option to activate the Manual IP Address Setting fields.
• With assistance from your IT administrator, fill out the fields and Click OK.
• In the Networking Configuration window, go to File → Save to save your settings. 
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• To quit the application, go to File → Quit. 

5.9  Remote Shutdown 
Clicking the Remote Shutdown button will allow the user to shutdown one or more screens. 

• Click on the Remote Shutdown icon.

• The following window will appear (Figure 84):

Figure 84: Remote Shutdown 

• Select the servers you want to shutdown or reboot. 
◦ To select more than one server, hold down the Ctrl button.

• Set the amount of minutes until the reboot or shutdown in the Minutes field (Figure 84).
• Click the Shutdown or Reboot button (Figure 84).
• To cancel the shutdown or reboot, click the Cancel Shutdown button (Figure 84). 

This completes the procedure for setting up the TMS application. 
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6  Acronyms
Term Definition
CPL Composition Playlist
DCP Digital Cinema Package
GPI General Purpose Input
GPO General Purpose Output
KDM Key Delivery Message
SPL Show Playlist
SMS Screen Management Server
LMS Library Management Server
TMS Theater Management System
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7  Document Revision History
Date Version Description

09/02/2008 1.0 First Version.

04/08/2009 1.1 All sections revised.

04/08/2010 1.2 All sections revised.

07/11/2012 1.3 All sections revised. 
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